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Vorbemerkung und Disclaimer
Vorbemerkung

“Rechtschreibfehler in diesem Howto, sind inbegriffen und sind mit
Absicht zur Belustigung des L esers gedacht.”

Wieist dieses Projekt entstanden?

Gute frage... nachste frage... nein Spal3 bel Seite,
ich denke das ganze hat damit angefangen das die Frau von “grizzly”
gesagt hat

“Das doofe Startbild misste man doch eigentlich auch andern kdnnen?!”.

Worauf “grizzly” den ersten Teil des Projektes begonnen hatte. Warum ich
mir das nur Denke? Ganz einfach ich kam viel spéter dazu... habe den
Beitrag von “grizzly” im www.navi-forum.net beztiglich der fehlenden
Farbtabellen gelesen und habe Ihn dann ganz einfach angeschrieben.

Prompt kam eine Antwort mit den nétigen Dateien und ich machte mich
daran die Farbtabellen zu suchen... In kurzer Zeit war dann auch das
Geschichte und daraus entstand dann eine Zusammenarbeit zwischen
“grizzly” und *blackice2999” wodurch dann www.navi-projekt.de und
Kolumbia zu dem geworden ist was es heute ist.
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Wieso hell3t das Programm eigentlich “Kolumbia” ?
Hierzu kurz ein Auszug von “grizzly’s’ Posting im Board:

Heute "ein kleiner Schritt fur mich, ein grof3er Schritt fir alle Navi Fans®
imMemoriam der 7 gestorbenen Astronauten der Columbia am 1.2.2003
schlage ich vor die Software "Kolumbia" zu nennen.

ich hab das eigentlich absichtlich so gemacht, um das neue Projekt den
beim Absturz umgekommenen Personen zu widmen. Das soll also in
keinster Form ein Spald dartber sein, sondern eine Wirdigung ftr die
Astronauten ausdr ticken.

Einfach weil ich fast genau in der Minute mein erstes Navi erfolgreich
geflasht hatte. Und wenn wir so dazu beitragen kdnnen mit einem schonen
Projekt den Namen hochzuhalten, dann finde ich das eigentlich nicht so
schlecht gewanhlt.

Aber wie auch immer ich akzeptiere nattrlich eine Meinung, und wenn es
auf zuviel negative Meinungen hinlauft, und jemand einen ganz Guten
neuen Vorschlag macht, bin ich gern bereit dem Kind nen anderen Namen
2u geben.

(aber nicht dem Kind, das hat einen festen Namen)

_—
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Disclaimer

|ch mOchte an dieser Stelle nur noch mal den Punkt 5 unseres Disclaimers
Publizieren. Den kompletten Disclaimer konnt Ihr jederzeit im
www.havi-projekt.de nachlesen.

5. Softwar eangebot & Downloadangebot

Dieim Board von www.navi-projekt.de zur Verfligung gestellte Software
"Kolumbia", dient lediglich zum Privaten Gebrauch. Eine Verbreitung der
benotigten Firmware innerhalb dieses Boards ist nicht zulassig und wird
daher auch nicht geduldet. Postings die darauf verweisen werden
umgehend gel 6scht, soweit es der Administrative Aufwand zulasst. Die
Benutzung der Software "Kolumbia' geschieht auf eigenes Risiko und
dient nur zu Experimentellen Zwecken. Die Urheber der Software Haften
"NICHT" fir evtl. daraus Resultierende Schaden. Ein Rechtsanspruch an
die Software bzw. das Wissen was daraus erlangt wird besteht nicht.
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S0 jetzt aber genug Geredet...
Kommen wir zum Teil ,eins* der Howto... die Grafikvorbereitung
Fangen wir schritt fir schritt an.

|ch gehe jetzt einfach mal davon aus, dass Ihr euch das Programm
Kolumbia bereits runter geladen, entpackt und Installiert habt.
Wenn nicht einfach auf www.navi-projekt.de gehen und saugen...

Als néchstes nehmen wir en Grafikprogramm unserer Wahl z.B.
Photopaint od. Photoshop, wer jetzt ein so teures Grafikprogramm nicht
zur Verfigung hat, kann alternativ entweder zum Imaging von Windows
XP greifen oder man besorgt sich ein Freewareprogramm wie z.B.
GimpWin von www.gimp.de

Ansonsten habe ich ein Freeware Programm gefunden was uns nattirlich
zwei Vorteile bringt... zum einen ist es kostenlos und wir kdnnen es evtl.
zum download mit anbieten... oder erstmal noch von hier
www.irfanview.com runterladen.

Anhand dieses Programms werde ich euch nun versuchen den Ablauf zu
erklaren...
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Als erstes Starten wir erstmal unser Grafikprogramm, in diesem Fal|
»IrfanView* Und gehen dann auf File -> Open, dort wahlen wir unsere
Ausgangsgrafik aus z.B. Photo von der Digitalkamera.

E}prugramm_lugu.hmp - IrfanYiew - 10| x|
File Edit Image ©Options Mew Help

EREEX| iR |06 C «=1

20234 x 24BPP [13/15 [100% 219.43KE[219.36KE

Als néchstens mussen wir das Bild auf unsere gewtinschte Grol3e von
320x234 bringen. Dazu gehen wir auf Image -> Resize wo wir dann mit
Width & Height die GrofRe auf 320x234 bringen.

Current zize: 320w 234 pirels
M ew zize: 320 % 234 pivels

{* Set new size:

Width: |32|:| Height: |234
DPI: IEIEi Units: €% pixels

= cm
i~ inches
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Daswar es schon fast... aber nur fast, jetzt mussen wir noch die Farben
auf < 256 Farben bringen und als BMP Speichern.

Also auf Image -> Decrease Color Depth bei Custom z.B. 200 eintragen
und auf OK klicken. Ich nehme meistens weniger so um die 100 — 150 ist,
meinem Erachten nach ein guter Wert.

ektL0go.jpg - It =18l x|

Dphions  Wiew Help

EEEX| i RBRS| D& «=

y [ Colors

{256 Colors
{16 Colaors
= 2 Colars [Black e hite)

¥ Custom: lEEIIJ [2 - 256 colors]

ok | Cancel

320 % 234 x 24 BPP 1115 |100% [13.23KB[219.35KE

Jetzt nur noch auf File-> Save As alsBMP im Kolumbia Verzeichnis
abspeichern und Programm schlief3en.
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Tell ,zwe“ Grafiken mit Kolumbia einflgen.

Wie auch im ersten Teil erwarte ich natlrlich das Ihr ein wenig Vorarbeit
geleistet habt und zwar das Ihr euch die Updatefiles fir euer Navi+ oder
MFD besorgt habt. Wo Ihr die herbekommt mochte ich an dieser Stelle
nicht erwéahnen, aber ich denke mal dawerdet Ihr den Link schon zu
finden ;)

So und jetzt Sammeln wir uns noch mal und schauen ob wir alles haben:

- Update CD entpackt und evtl. aus .NRG Image extrahiert (geht
wunderbar mit Winl SO oder IsoBuster.

- Kolumbiainstalliert

- Grafik als Bitmap 320x234 und < 256 Farben. Tipp: Wenn ihr das
Bild bereits im Grafikprogramm auf 30-40 Farben bringt, konnt Ihr
in etwa abschatzen wie die Farben nachher im Navi aussehen.

- Und zu dler letzt viel mut zum flashen ;)

Wenn das alles beisammen ist geht es weiter und wir starten Kolumbia
was dann so aussehen sollte.

3 Kolumbia ¥:0.2.0 vom: 5.2.2003 =10}

Datei Irfo
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Langsam féllt mir nicht mehr ein wie ich die Sétze anfangen soll...
aber es geht schon irgendwie... *fg* soll ja nicht super aussehen Sonder
verstandlich sein *noch mal fg*

Und ab auf ,, Open Firmware File"* jetzt nur noch dierichtige Datei
auswahlen. Hier eine Auflistung der einzelnen Dateien.

Datei
AUDGI1B07.DNL
AU2G8C08.DNL
V2DGO0B16.DNL
V2D G2322.DNL
VW2G9408.DNL

RG9G0A19.DNL

Typ Model

Audi Navi+ DX

Audi Navi+ nonDX

VW MFD C&D 16.11.2002
VW MFD C&D 22.03.2002
VW MFD A&B

Blaupunkt DX-N (comming soon)

Wieihr jetzt seht sind die restlichen Felder frei.

Ed Kolumbia ¥: 0.2.0 yom: 5.2.2003
File Infa!

=101 =]

Beenden ] | QOpen Firmware File

Hew Navi-Boot Grafik ] Shov Deutzche Tedte ] Show Wersion Teste I

Ini ] Save Firmware File

Show Mavi-Boot Grafik, ] Show Englizche Teste ] Show Boot Texte I

Datei AUDG1BO7.DNL

Infio Wergion :SH -- AUD1 Navi+ D Datum:07. 11,2001

Kurz zur Erkléarung:

Save Firmware File
New Navi-Boot Grafik
Show Navi-Boot Grafik
Show Deutsche Texte

Show Englische Texte
Show Verson Texte

Show Boot Texte

Abspeichern der gednderten Firmware
Neues Bootlogo einfligen (unsere BMP).
Zeigt das Bootlogo im Flash an.

Hier stehen die ganzen Meldungen vom Navi
drin. Andert geht, aber nur in der gleichen
Lange.

Hier gilt das gleiche wie fir Deutsch.

Zeigt ale Versonsmeldungen an. Von ener
Anderung ist derzeit noch abzuraten.

Zeigt ale Boot Medungen an, auch hier gilt
Finger weg vom Andern (noch).
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Aber wir wollen jajetzt erstmal nur das Bild andern. Wo ich an dieser
Stelle noch mal alle rum bitten mdchte, jeder der erfolgreich sein Navi
geflasht hat - und es wird erfolgreich werden- , den mochte ich noch mal
darum bitten ein Foto zu machen und im Board unter Bildergallery zu
veroffentlichen. Und weiter geht es...

Wir klicken auf ,, New Navi-Boot Grafik® und ihr seht folgendes Fenster:

k3 Neue Grafik erstellen -10] x|
File Grafic ColT able from File Grafic
[ ] 1] AEEEEEEEN
H BEEEEE"EE E EEm
PNEENE B B | ||
AEEEEEEEEEEEEEEE
o ]| [ | | HEEEER
ENEAEEEENEE EEEEm
HEEN HEE ETEE
iIH =N AEEENEEER
AEEENEEEEEEEEEEn
EEEEEEEEEREEENEN
ANEENEEEENEEEEE.
AR EEENEEEE e
AEEEEEEEEEEEEEEE
ANEEEEEEEEEEEEEN
HEEEN Hn [ |
ANEEEEEEEE EEEEE
[Dratazize 0 |= 0 x
Schrtt 1 Lade Grafik auz Datei [*.bmp] |
Schritt 2 Bonwert iers ins Hav: Fopmsd -3
e
M| Grafic kain CalT able from BIM File
HEEN EREEEERET
H EEEEEYEE ETEE
FEEE B B EEEE
AEEEEEEEEEEEEEEE
ER EEREE
INEEEENNEE EEEEN
HEEN HEE ETEEe
[ | | HEENEEEENR
ENEEEEEEEEEEEEEE
HEEEEEEEEEEEETEEw
ANEESEEEEEEEEEEe
AEEEEEEEENEEEEEE
ENEEEEEEEEEEEEEE
ANEEEEEEEEEEEEEn
HEEEEE || [ |
ANEENENEEE EEEEE
Datasize |0 | =0 4
Space RCEZ =0 %
Schritt 3 pmc e an aw M Sy LR ____________________
Schritt 4 <eige Grafik. auzs Flashfile |
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Ab jetzt sollte es elgentlich kein Problem mehr sein...

Schritt 1 = BMP was wir zuvor konvertiert haben
einladen und anzeigen.

Gefolgt von

Schritt 2 =  Umwandlung der Farben, hier rechnet das
Programm die Farbtabelle so lange um, bis
die Grafik in das Flash passt. (je nach
System kann es ein wenig dauern)

Jetzt kommt der interessante Schritt, wie man so schon sagt:

» Ein kleiner schritt fur die Menschheit ein grol3er Schritt firs Navi®

Schritt 3 = Was soll ich hier Schreiben 2! Klick und
drinist die Grafik *fg*

Schritt 4 = Hier konnt Ihr euer Bild noch mal im Flash
Anschauen. (Show Navi-Boot Grafik)

So viel zum Programm Kolumbia, nur noch auf Beenden und Save
Firmware File anklicken und das war es dann.

Euer Flashfileist fertig.
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Der letzte Teill desHowto's,, Tell , drei“ das Brennen.

Und auch in diesem Teil, gehe ich davon aus, das Ihr einen Brenner habt
und evtl. auch noch Nero.

Am leichtesten ist es wenn |hr euch jetzt ein neues V erzeichnis macht und
die bendtigten Dateien furs Flashen dort reinkopiert. Wichtig dabel ist es,
die Originale Flash Datel die ihr ja gedandert habt, darf auf KEINEN FALL
mit auf der CD sein, es sei denn Ihr habt sie einfach nur Uberschrieben.
Ich liste einfach mal als Beispiel die Dateien auf die fir das Navi+ DX von
Audi notwendig wahren.

Original Flashverzeichnis Geandertes Flashverzeichnis

_lojx ol
Datei  Bearbeiten  An: * | e Datei  Eearbeiten  ane |

ek - o & e L o »
e | 7 ir | 3 ZUFHGH Ld ir |

fdresse J |N|:|rt|:|n Ankivirus E, - Adresse 1 | Morkan Ankivirus E, -

| AU4M1CL7.DML = AU4M1C17. DML

AUDGIEDT DML i ALDG1E08. DhL

=] ALDMIB1S.DNL =] AUDMIELS. DL

=) ALIGI1 125, DAL ] ALGM1125, DML

Clcomp_pLEsE Tlcomp_DLLEXE

= conFlG.5vs = ConFlG.SvS

= DFLASHDL.EEX = DFLASHDL BEX

| FILL1.DAT E|FILLLDAT

S|FILL.DAT S| FILL.DAT

PARAM, 5Y5 PARAM.SYS

Wie Ihr hoffentlich seht, habe ich die neue Flashfile AUDG1B08.DNL
genannt. Die Alte habe ich gel6scht. Warum? Ganz einfach, das Navi
schaut beim Updaten nicht auf die Dateinamen, sonder geht in die
einzelnen Dateien rein und schaut in den Header ob es eine Update Datei
ist, wenn jetzt 2mal die gleiche Datei existiert, wissen wir NICHT was
passiert.
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CD-Brennen

Wenn auch dieses Erledigt ist, heil% es Brennen.
(Erstmal ne Zigarette anmachen, nach dem ganzen getippe hier.)

Das Brennen werd ich jetzt nur mal kurz ansprechen, weil wohl jeder von
Euch schon mal eine CD Gebrannt hat.

SO 9660

Mode 1

| SO 8.3 Dateinamen

kein Multisession

Session abschlielen

nicht zu schnell brennen....

Das zum Thema Brennen... je langsamer desto sicherer

Kolumbia: Page 13 of 14 coding: grizzly
Graphics & Lyrics: Blackice2999

v0.2.0 Stand:5.2.2003

© 2003 grizzly@navi-projekt.de



Kolumbia Howto by Blackice2999 09-02-2003

Die Stunde der Wahr heit

Ab ins Auto, Zundung Einschalten! Und anlassen wéhrend des Updates!!!
Teleatlas CD raus, eigene Grafik Update CD rein,

ausschalten.....

FUr Audi: Tasten "Navi"&"Fahnchen"
Fiar VW:"AS'&"Info"

gedrlckt halten, und einschalten.

Dann kommt der " Softwareupdate von CD" Dialog auf dem Bildschirm.
Falls die CD noch mal ausgespuckt wird, einfach wieder reinstecken.
(War eigentlich immer so, warum weis ich nicht)

Warten bis das jewellige Updatedatum angezeigt wird.

Auswahl von "Starte Bedienteil", dann rechts klicken.

Jetzt geht eslos, 2x blauer Balken von links nach rechts.

Zwischendrin geht das Navi vielleicht mal kurz aus, aber keine Sorge, das

geht auch von allein wieder an...

1/2h warten, wenn der 2.Balken fertig ist, Augen auf....... Foto machen
und ab ins navi-projekt unter Bildergallery.

Wer noch fragen hat bitte ins navi -projekt.de Posten, dafir ist ja das Board
da.

ENDE (jetzt aber ins Bett)

Gruf Blackice2999@d2mail.de
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